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About This Manual 

This manual provides an introduction to the ‘OEM’ Mobility PC Programmer. 

Icons 

Throughout this manual, icons are used to draw the reader’s attention. 

The icons used are: 

Note – A general point for best practice. 

Caution – A point of safety, which if ignored, could result in damage to the control system or the 
vehicle. 

Warning – A point of safety, which if ignored, could cause injury to the individual. 

 

PG Drives Technology accepts no liability for any losses of any kind if these points are not 
followed. 
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1 Introduction 

The Mobility PC Programmer is a Windows™ based software package that allows parameters to be viewed, edited, saved as files 
and copied between control systems. Parameters can be modified off-line and saved, creating new control system variants 
instantly and remotely. Whole sets of parameters can be transferred from programmer to control system, or vice-versa by a single 
command. In addition to intuitive programming, the Mobility PCP also provides invaluable diagnostic support and a ‘password 
protection’ utility, which makes it suitable for ‘end-of line’ programming. 

It is possible to set up a control system so that it is unsuitable for some users or even some 
vehicles. For all of the above reasons it is important that you contact PG Drives Technology if 
you have the slightest doubts or if you need any advice on programming.  

Programming and diagnostics should only be conducted by healthcare professionals with in-depth 
knowledge of PG Drives Technology electronic control systems. Incorrect programming could 
result  in an unsafe setup of a vehicle for a user. PG Drives Technology accept no liability for any 
losses of any kind if the programming of the control system is altered from the factory preset 
values. 

1.1 Hardware 

The Mobility PC Programmer is comprised of the following parts. 

CD ROM. 

Programming Cable. 

USB-to-Serial Adapter Kit. 

Installation Manual. 

1.1.1  CD ROM 

The CD ROM contains installation, executable and information files. 

An electronic copy of this manual is also stored on the disc. 

1.1.2 Programming Cable 

The programming cables connect the PC to the vehicle control system via a communications port. There are two cables 
supplied, one for wheelchair control systems which terminates at one end in a RS232 connector and at the other in a Neutrik plug 
suitable for connection to VR2, VSI and Pilot+, the other is for scooter control systems which terminates at one end in a RS232 
connector and at the other in a Molex ‘Mini fit Jnr.’ 4 way plug suitable for connection to S-Drive and Egis control systems. As 
different control systems and PC’s are developed, alternative cables may be necessary.  

1.1.3  USB-to-Serial Adapter Kit 

The USB-to-Serial Adapter Kit is designed for PCs that do not have a serial communications port. The kit comprises of a USB-to-
Serial adapter plug, a driver disc and a USB extension cable. 

1.1.4 PC Compatibility 

To run the PC Programmer effectively, the minimum requirements are: 

Microsoft Windows™ 2000. 

CD ROM drive. 
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40Mb free storage space on hard drive. 

Spare communications port. 

1.1.5 Control System Compatibility 

This issue of Mobility PC Programmer software is compatible with the following PG Drives Technology Control Systems: 

 VR2 

 VSI 

 Pilot+ 

 S-Drive 

 Egis 

1.2 Installation 

Once the CD ROM is loaded into the PC, the installation of the programmer is fully automatic. 

The software will be installed in: 

C:\Program Files\PG Drives Technology\PC Programmer – Mobility 

When using foreign operating systems, the installation directory will be in that language’s 
equivalent of ‘Program Files’. 

If the CD ROM fails to run automatically, double click the CD icon within ‘My Computer’. 

When the installation is complete, the icon shown below will appear on the PC’s desktop screen and in a new shortcut folder on 
the ‘Start’ menu. Double-clicking the icon will start the PC Programmer software. 
 

 

 

1.2.1  Communications Port 

The PC Programmer’s default communications port is ‘COM1’. If necessary, a different communications port can be selected 
after the initial installation, using the ‘Options’ utility in the ‘Tools’ drop-down menu. 
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1 Connection to a Controller 

For programming operations you can connect the PC Programmer cable to a control system at any time, regardless of the 
operating condition of the control system.  

The control unit must be connected and ON before program transfer can be achieved. 

If you are using the PC Programmer for diagnostics purposes, then to view the current trip code you must connect the PC 
Programmer while the control system is in a tripped state, i.e. the battery gauge is flashing rapidly.  

To attach the control system to the PC use the programming cable as follows: 
 

 

 

If the PC does not have a serial communications connector, use the USB-to-Serial adapter plug supplied. 

 Insert the plug into one of the PC’s USB ports. 

 When prompted, browse for the adapter’s drivers (these are found on the accompanying disc). 

 Once the drivers have been installed successfully, connect the programming cable as described below. 

Only use the adapter plug supplied with the PC Programmer. The use of other adapters may 
result in an inconsistent communications signal. 

The PC Programmer should be connected to the controller as follows. 

 Insert the programming cable’s D-type plug into the PC’s serial communications port or to a USB port, via the 
adapter plug. 

 Insert the programming cable’s 4-way Molex ‘Mini-Fit Jr.’ plug into the controller’s dedicated programming 
connector. 

 Switch the controller on. 

The ‘Comms Active’ message should be displayed in the PC Programmer’s Status Bar – see Section 3.6 for details. 

Remember to disconnect the PC Programmer from the controller before vehicle drive commences. 
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2  Initial Operation 

PC Programmer can be used to edit existing control systems or to perform initial programming acts. Once a program has been 
loaded into PC Programmer editing tasks can be performed at any time. 

Upon opening PC Programmer the following warning window will appear. It is important that this warning is read and understood 
before programming commences. 

 

 

 

Clicking Continue opens the PC Programmer Application Window. If a control system is connected, and ON, then the status bar 
will state what type the connected system is.  

If the Control System is not supported by the version of PC programmer currently installed then the program will alert the user. 

Once opened one of three things must occur to begin using the PC Programmer. 

 A new Template must be opened. – File>New 

 A previously saved file must be opened – File>Open. 

 A file must be read from the controller – Controller>Read From Controller. 

3 The Application Window 

For ease of description the application window will be separated into 6 different sections. These are: 

3.1 - Program Information Bar 

3.2 - Drop Down Menus 

3.3 - Toolbar 

3.4 - Program Button 

3.5 - Program Display Area 

3.6 - Status Bar 
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3.1  Program Information Bar 

3.1.1  Description 

The description box displays user defined information about the current program being viewed. When a new program is opened 
the description will read Default Program until it is adjusted 

 

   

Original      Adjusted 

As soon as the program is adjusted a <Mod> notation will appear after the description. 

3.1.2 File Name 

The file name box displays the user defined name for the current program being viewed. When a new program is opened the 
name will read Default Program until it is adjusted 

 

   

Original      Adjusted 

 

As soon as the program is adjusted a <Mod> notation will appear after the name. 

3.1.3 Program 

Each control system produced by PGDT has a set of Default Values and a set of Working Values. The Default Values are used 
when a programmer wishes to return to the control system’ s basic setup if, for example, the vehicle is not reacting as expected 
to parameter changes.  

 

  

 

With the Program Presets set to YES the next time the Program button is pressed the Default and Working Values will be overwritten.   

With the Program Presets set to NO the next time the Program button is pressed only Working Values will be overwritten. 

The Program Button downloads the program parameter information from the SELECTED Group into the control system connected. 
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3.1.4 Group Menu Selection 

The Group menu selection is a drop down menu. The menu lists the program parameter groups which are available for display 
and adjustment either individually or as a whole.   

 

 

When the file is in a PROTECTED state the only Group available is ALL. 

3.1.5 Identification Fields 

When the Serial Number field in the Options drop down menu has been set to Yes, this is where the information will be displayed. 

 

 

The Vehicle Serial Number is requested when programming of the controller is attempted. The Controller Type Number and the 
Controller Serial Number are then read from the controller it self. Refer to section 3.2.4.    

 

3.2 Drop Down Menus 

3.2.1 File 

This menu contains standard Windows operational elements. 

 

 

When opening a New program the menu will display the current list of templates available. One of the templates must be 
selected. 
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A new function to the standard print menu is the ability to choose the type of print required.  

Normal -  When the print option, in this menu, is used only the parameters listed within the Group Menu 
Selection will be  printed. 

Condensed -  This option is of note as it allows the operator to print all of the parameters within the file on one side 
of A4 paper. 

3.2.2 Controller 

This menu contains specific programming tools. 

 

  

Write Controller -  Downloads ALL the program parameter information into the control system connected. 

Read Controller - Inputs all the program parameter information from the control system connected. 

Preset -   Restores all program parameters to the control system’s PRESET values. 

3.2.3 Tools 

This menu contains specific control system information tools. 

 

  

Diagnostics -  If the connected control system is in a tripped state then this option will display the specific trip code 
and type. 

System Log -  Displays the diagnostic Log of the connected control system. Within the window is also the option to 
clear the Log information. For detailed information on the System Log window refer to section 4. 

Timers -   Displays the connected control system’s timer information. This is in the form of an hours run timer, 
which refers to the time the control system has been driven.  

Controller Info -  Displays control system specific information such as the Controller Serial Number. 



 PC PROGRAMMER MOBILITY – MAN PG DRIVES TECHNOLOGY 

14 SK76982-08 

Protect -   Allows PC Programmer to be secured using a password. Once the program has been protected 
users can only Open/Close , Read From / Write To and Program attached control systems. When a 
file is protected PC Programmer will only allow ALL groups to be viewed.  

Comms -   Allows the user to select which communication port to attach the control system to the PC.  

File Type -  Displays the format in which the file was created. ie. Dealer, OEM or Manufacturing Programmer. 

3.2.4 Options 

This menu contains selective options to enable customization of the workspace 

 

  

Vehicle Serial Number -  

When set to Yes this allows PC Programmer to record the Controller Type Number, the Controller Serial Number and the Vehicle 
Serial Number of the vehicle onto which the parameters have been loaded. 

When Yes is selected the following window will appear asking for the correct quantity of characters for the Vehicle Serial Number.  

A number between 4 and 32 or Any can be selected. (Any has a minimum requirement of 1 character) 

 

 

Once the desired quantity is selected clicking on the OK button will open a window asking for a saving location for the program 
file.  

The next time either the Program or Write to Controller buttons are clicked PC Programmer will request a valid Vehicle Serial 
Number. 

If multiple Vehicle Serial Number lengths are used on your production line then it is suggested 
that the Any value is selected. 

Once a valid number has been entered PC Programmer will read the required controller information and save it all within the file 
location previously selected. The file name will be the entered Vehicle Serial Number. Example - xxxxxxx.prg 

If a Vehicle Serial Number is entered that does not equal the quantity of characters selected then the programmer will display a 
window saying, Enter Correct Vehicle Serial No. 
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Warnings -   

As PC Programmer is issue sensitive, warnings are displayed if all the parameters available on the PC are not located on the 
controller connected.  

These warnings can be switched off by selecting No within the warning dialogue box. 

PG Drives Technology accept no liability for any losses of any kind if this function is set to No.  

Erase Timer System Log Control & Log -  

Once the programming of a controller is complete the Elapsed Timer, System Log and Control Log can be automatically erased. 
Each option can be set individually to Yes or No. 

If set to Yes, then after programming all entries will be deleted.  

If set to No, then no entries are deleted. 

3.2.5 Help 

This menu contains specific information about the PC Programmer software. 

 

  

Contents -  Displays the available Help topics. This follows a Windows typical control method. 

About Box -  Displays the PC Programmer software issue information. 

3.3 Toolbar 

The toolbar icons are shortcuts to the most regularly used functions within the drop down menus. 

 

 

The Select File Template window will only appear when the New File button is clicked. 

Viewing the different file types available is achieved using the arrows. 

To select the desired file type, simply click on the name when it appears. 
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3.4 Program Button 

Downloads the program parameter information from the SELECTED group into the control system connected. 

  

3.5 Program Display Area  

All adjustments to the program parameters are made within this window. 

Each programmable parameter has its own adjustable entry. All of these parameters have a Help icon located next to them 
which give a brief description of what the parameter controls. 

  

Where a parameter has a Warning icon the warning should be read and understood before 
adjustment to the parameter is attempted. 

To adjust a parameter, move the mouse cursor to the parameter reading and click on the arrows to increase or decrease the 
reading. 

Where there is a toggle selection instead of a reading then simply click on the required selection. 
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3.6 Status Bar  

Displays program relevant information. 

 

 

1 - Protect  -   When the PC Programmer has been password protected the protection box will show PROTECTED to 
alert the user. 

2 - Trip Box -   When the connected control system has tripped the trip box will display TRIPPED to alert the 
programmer. To view the trip code select Diagnostics in the Tools drop down menu.  

3 - Access Level - Displays the level of access available with the installed version of PC Programmer. 

The Three types of access are: 

   Level: A (Dealer)          
   Level: B (OEM)          
   Level: C (Manufacturing) 

4 - Control System -Displays the type of control System currently connected to the PC.  

5 - Activity -   Displays if a control system is switched ON. If a control system is connected but not ON then the 
Activity will display COMMS INACTIVE. 

4 System Log Window 

Displays Control system trip information. 
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Control System -  Details the type of control system currently connected to the PC, the control system’s software issue and serial 
number.  

System Log -  The system is tripped out in response to an issue external to the control system. The system log lists the last 8 
types of system trip that has occurred since the system was either initialized or last cleared. Each type of trip has an occurrence 
value and a brief description. 

If there is a control trip then the system log records it under a general code which alerts the 
technician to check the control log. 

Control Log -  The control log registers a trip in response to an issue within the control system. The system log lists the last 8 
types of control trip that has occurred since the system was either initialized or last cleared. Each type of trip has an occurrence 
value and a brief description.   

There are no serviceable parts within any of the PG Drives Technology control systems. 
Consequently, any defective units must be returned to PG Drives Technology or a PG Drives 
Technology approved service organization for repair. PG Drives Technology accept no liability for 
any losses of any kind arising from unauthorized opening, adjustment or modification to any 
component of a control system. 

A description of the each trip code can be found within the Help facility under - Index   

The system log window has a row of options along the base. These are: 

Copy -   Allows the user to copy and paste the logs to another file. 

Warning -  It is important that this warning is read and understood before further action is taken to correct any trips. 

Print -   Prints the system log window to the PC’s default printer.   

Clear System -  Clears the control system’s system log. 

Clear Control-  Clears the control system’s control log.   

OK -   Returns the user to the program display area.   
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5 Upgrades 

Once a copy of the PC Programmer has been purchased, the user is entitled to free upgrades. This means each time a new 
programmable function or utility is introduced, the programmer can be updated to the latest version. 

To qualify for free upgrades, the following information should be sent to ssrt@pgdt.com: 

 User name 

 Business name 

 Business address 

 Product type – this is the number, ‘Dxxxxx/x’, which can be located on the packing box, the CD wallet and the 
cable labels. 

 Product serial number – this is the number, *xxxxxxx*, which can be located on the packing box, the CD wallet 
and the cable labels. 

Once qualification has been recognized, an email will be sent containing a unique username and password. 

This username and password allows access to the latest software via the www.pgdt-ssrt.com website. 

This is achieved as follows: 

Upon entering www.pgdt-ssrt.com enter the unique username and password. 

Select the relevant software group from the list of groups displayed. 

Click on the relevant file to start the download. 

Follow the instructions on screen. 

It is recommended that the Issue Log is read prior to a download being attempted. The Issue Log 
contains a complete history of the improvements, adjustments and changes created within each 
issue. 

The version of software currently installed on the PC can be checked by using the About Box 
located in the Help pull-down menu within the Mobility PC Programmer. 

Each upgrade will have an electronic manual specific to that version within the self-extracting Zip. 

 

 

 

 


